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Pyramid Consulting, Inc., and our operating affiliate divisions (Genspark™ and 
Celsior Technologies™) is committed to protecting and respecting your 
privacy. Accordingly, we have developed this Privacy Notice for you to 
understand how we collect, use, communicate, disclose, and make use of 
personal data through our website. 

 The terms “we,” “us,” and “our” refer to Pyramid Consulting, Inc., and its 
affiliates (the “Company”). 

 The term “Site” refers to www.pyramidci.com; www.genspark.net; 
www.celsiortech.com  

 The terms “user,” “you,” and “your” refer to Site visitors, candidates, and 
any other users of the Site. 

Use of the Site, including all information presented herein and all online 
services provided by the Company, is subject to this Privacy Notice. 

Who are we? 
Pyramid Consulting, Inc. is an award-winning, global staffing company, and 
one of the leading and most reliable sources of the best total talent and 
technology services in the industry. We are committed to satisfying the needs 
of all customers: our clients, consultants, and employees. 
 
As a customer partner-for-life, through our four divisions, we provide the best 
in people resources, utilize the latest technology in our IT and workforce 
transformation projects, and bring subject-matter expertise, all to help our 
customers achieve success.  
 

Who does this Privacy Notice protect? 
This Privacy Notice applies to all Site visitors, candidates, and all other users of 
the Site. By using the Site or any of its services, you agree to this Privacy 
Notice, without modification, and acknowledge reading it. 

 
What information do we collect? 
When you use or register with the Site, some of the data that we collect and 
receive from you is personal data, which means that it is information that 
could personally identify you (“Personal Data”). 
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The categories of Personal Data we may request include your name and 
contact information (email address, address, and telephone number). 
Depending on the nature of your inquiry or activities on the Site, we may also 
ask for your job search criteria and preferences, your employment experience, 
educational history, your skills in various areas, reference information, 
background information, and other information contained in your resume, 
and any login ID and password created by you. It is also possible to upload 
your resume/CV, cover letters, and any other attachments you may wish us to 
consider. The Site also utilizes functional cookies to track your online activities, 
including, but not limited to, registration, submissions, information requests 
and for analytic purposes. 
 
The Company currently does not recognize and respond to Do Not Track 
Signals. If we do so in the future, we will revise this Privacy Notice to describe 
how this is done. 

 
Why do we process your Personal Data? 
We use your Personal Data for our business and activities, and in our efforts to 
expand and improve our business. Generally, we use Personal Data and other 
data collected through the Site to register you with the Site, to provide you 
with information regarding employment opportunities and career-related 
information, and to otherwise provide you with requested information or 
services. 
 
We may also from time to time use your Personal Data to send you 
automated email messages regarding our services, including employment 
information. You have the right to ask us not to process your Personal Data for 
marketing purposes and can opt out of receiving such email messages by 
sending an email with this request to dpo@pyramidci.com from each e-mail 
account that you would like to opt-out from. 

 
With whom do we share your Personal Data? 
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The Company may disclose Personal Data to third parties. The disclosure to 
third parties would occur in the following circumstances: 

 We will disclose information to our clients when necessary and 
appropriate in connection with the provision of staffing and recruitment 
services. 

 We may disclose information to companies and individuals we employ 
to perform business functions and services on our behalf. 

 We may disclose information to the extent necessary or appropriate to 
government agencies, advisors, and other third parties in order to 
comply with applicable laws, the service of legal process, or if we 
reasonably believe that such action is necessary to: (a) comply with the 
law requiring such disclosure; (b) protect the rights or property of the 
Company; (c) prevent a crime or protect national security’ or (d) 
protect the personal safety of the users or the public. 

 
What rights do you have? 
We respect your right to review and request changes to your Personal Data. 
The amount of Personal Data you are required to provide when requesting our 
services is consistent with the Company’s interests in providing our services to 
you. The Company complies with applicable data protection laws and 
regulations. 
 
We process Personal Data about you for the purposes set out in this Privacy 
Notice, including, but not limited to providing recruitment, placement, 
employment, or outsourcing services; operating our business; complying with 
our legal and contractual obligations; and fulfilling other legitimate interests 
of the Company. 

 
Changes to this Privacy Notice 
We reserve the right to update this Privacy Notice periodically to reflect 
changes in our privacy practices and legal updates. Any changes we may 
make to our Privacy Notice in the future will be posted on this page and are 
immediately binding without any requirement for notice. 
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How to contact us? 
If you have any questions or comments about this Privacy Notice, or if you 
would like to exercise your rights, please send an email 
to dpo@pyramidci.com. or write to:  Data Privacy Officer – Pyramid 
Consulting, Inc., 3060 Kimball Bridge Road, Suite 200, Alpharetta, GA 30022 
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Introduction   
  
Please Read Carefully.  
  
Pyramid Consulting, Inc. (USA), Pyramid Consulting, Inc. (Canada), Pyramid IT 
Consulting Pvt. Ltd. (India) and its subsidiaries (Singapore, UK, Mexico), affiliated 
divisions – Celsior Technologies®, Genspark®, Celsior Technologies Pvt (India), 
Pyramid Systech Pvt (India), The Pyramid Companies, Inc. and its subsidiaries (UK, 
Ireland), Pyramid Dynamics, S. de R.L. de C.V (Mexico) together with its subsidiaries, 
(collectively, “Pyramid”, “we”, “us” or “our”), recognize the importance of protecting your 
privacy. Our Web Privacy and Cookie Policy applies to your use of our public websites, 
as well as your personal and professional interactions with Pyramid employees. This 
Policy is designed to assist you in understanding how we collect, process, safeguard 
and disclose your personal information and your choices in making informed decisions 
when using the Site. We also describe how you can contact us about our privacy 
practices.  
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Our Web Privacy Policy  

  

Your Acceptance Through Express Consent  
This Web Privacy Policy describes how Pyramid collects, uses, and discloses certain 
personal information obtained through this Site and other Pyramid Consulting, Inc. 
business activity. This Privacy Policy is incorporated into, and is part of, the Terms and 
Conditions, which govern your use of Pyramid Consulting Inc.’s Properties, Services, 
Amenities, and this Site in general.  
  

The Types of Information We Collect  
The types of personal information we may collect from you, or you may choose to 
provide include:  
  

• Contact information   

• First name / last name  

• Email  

• Phone   

• Job class  

• Job type  

• Advertising / discovery source  

• Any additional notes they choose to provide.  

• Online identifiers attached to your device or account.  

• Information about your use of our websites   

• Your social media interactions with us (for example, when you “like” a post on 

social media platforms)  

• Technical information from advertisements we place on third party websites 

(such as your IP address, browser type and version, device identifiers, location 

and time zone setting)  

  
How We Use Your Information  
  
Our Communications to You – Offerings Where You Expressed Interest:  
When you visit our Site, you may be required to register with us or be requested to 
provide us with personal information. When you provide us with this information, we 
may use it to contact you about the opportunities in which you have expressed an 
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interest. Pyramid has a legitimate business interest to use the personal information we 
collect from you to provide such requested information. Where we have relied on your 
express consent, however, if you tell us that you do not want us to use this information 
as a basis for further contact with you (by contacting us and requesting our opt-out 
process), we will comply within 24 hours.  
  
Our Communications to You – Events, Newsletters and Marketing:  
In order to keep our candidates informed about our latest news, communities, and 
events, we may send texts, e-mails and marketing communications to the phone 
numbers or email address provided to us while registering on our Site or requesting 
information from us. Pyramid complies with applicable laws when using your personal 
information for this purpose, and where applicable relies on your express consent. If 
you opt–in to any of our email lists, newsletters or other promotional offerings and later 
change your mind, you may unsubscribe by following the instructions contained in each 
email we send to you.  
  

General Business Uses:  
We may also use the personal information we obtain about you for the following 
purposes:  

• Evaluating and improving our business reach – including decisions about where 

to develop new communities, the amenities needed and pricing.  

• Improving our business processes  

• Candidate Satisfaction Surveys  

• Enforcing our other legal rights  
  
Information Provided to Us About You by Third Parties  
  
Third-Party Content:  
We may present or embed content on our Site, such as resumes, that is provided by our 
third-party vendors. This content may contain links to other sites not operated by 
Pyramid or may request personal information. For example, this content may ask for an 
email address to subscribe to alerts or share a listing with a friend. This information is 
collected by our vendors and not by us. In some cases, these vendors may share the 
personal information they collect from you with us. We share and are co-responsible for 
the privacy practices of our vendors. We encourage you to review their privacy policies 
to understand how they will use and share the personal information you provide to 
them.  
  
Third-Party Usage:  
You may also separately share your information with other Web sites or entities, such 
as those that create professional marketing lists, to receive special offers and 
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promotions from their affiliates. These Web sites or entities may share your information 
with us. Pyramid is co-responsible for shared data between us and our partners. We do 
our best to collect your consent from our partners and will not use your data if consent 
has not been collected and shared legally.  
    
Marketing Data:  
Where applicable law allows, we will purchase marketing data from third parties and 
add it to our existing user database to better target our advertising and to provide 
pertinent offers in which we think you would be interested. We may also associate this 
marketing data with the personally identifiable information that you provide us. In all 
cases we will collect the data source and your consent records from these partners.  

  
Third Parties with Whom We Share Your Personal Information  
  
Third Parties for Retargeting Advertising:  
We will, in some cases, share information about how you use our Site with third-party 
vendors to present you with more relevant advertising. For example, our vendors may 
track your browsing activity on our Site using cookies to show you ads based on your 
interests when you browse the Web or use social media. Our vendors will, in some 
cases, also share information about your browsing activity on our Site with us for 
analytics purposes. Pyramid relies on your express consent for such processing of your 
personal information. More information on these cookies, including how to provide or 
revoke your consent, may be found in our Cookie Policy below.  
  
Service Providers:  
We may share your personal information with companies acting as our authorized 
agents in providing our services, including the following categories of service provider:  
  

• infrastructure and IT service providers, including cloud service providers.  

• marketing, advertising, and communications agencies  

• external auditors and advisors  

• Utility companies  

• construction service supplies such as painting contractors  

• candidate service providers such as pest control and appliance repair  

• cookie analytics providers  

• online advertisers  

• providers of website testing / analytics services  
  
Each service provider must agree to implement and maintain reasonable security 
procedures and practices appropriate to the nature of your information in order to 
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protect your personal information from unauthorized access, destruction, use, 
modification, or disclosure. Because we operate globally, we may transfer your 
information to other countries or jurisdictions. Binding Corporate Rules manage these 
transfers. If we make such a transfer, we will, or our vendors will, as applicable, provide 
the proper safeguards required by applicable law to ensure that your information is 
protected. More information on International Data Transfers of your personal 
information is below.  
  
Where we share your personal information for our legitimate interests you can object to 
this disclosure. Please be aware that when you object to disclosure of your personal 
information for Pyramid ’s legitimate interests it may affect the services we provide to 
you. More information on your rights is below.  
  
Legally Compelled Disclosure:  
We will also disclose your personal information when required to do so by law, for 
example, in response to a court order or a subpoena or other legal obligation, taxation 
authorities, in response to lawful requests by public authorities, including to meet 
national security or law enforcement agency's requirements, or in special cases when 
we have reason to believe that disclosing your personal information is necessary to 
identify, contact or bring legal action against someone who may be causing injury to or 
interference with our rights or property.  

  
International Data Transfers  
  
Processing in the US and Elsewhere by Registration on This Site  
Pyramid is a business that operates in the United States of America, Canada, Mexico, 
the United Kingdom, India, Philippines, and the EU. We may transfer the personal 
information we collect about you to recipients, and your personal information may be 
stored and processed in countries other than the country in which the information was 
originally collected, including the United States and elsewhere. When we transfer your 
information to other countries, we will protect your information as described in this 
Policy with respect to data transfers outbound from the European Economic Area (EEA) 
to the United States:  
  

• Pyramid has executed EU Binding Corporate Rules with respect to personal 

information collected in the European Economic Area and transferred to Pyramid 

in the United States and elsewhere.  

  

Pyramid Consulting, Inc. is proud of our compliance, cybersecurity, and data privacy 
programs. We invite you to contact us to ask questions and find out more about our 
data management practices.  
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Disclosure and Liability for Onward Transfer:  
Pyramid is required to disclose personal information in response to lawful requests by 
public authorities, including to meet national security or law enforcement requirements. 
Pyramid may, as disclosed above in Third Parties with Whom We Share Your Personal  
Information, transfer personal information onward to third parties. Pyramid remains.  
liable under the Privacy Shield Principles if a third-party process such personal 
information in a manner inconsistent with the principles, unless we prove we are not 
responsible for the event giving rise to the damage.  
  
Independent Recourse of Privacy Shield Complaints:  
In compliance with the EU-US and Swiss-US Privacy Shield Principles, Pyramid 
commits to resolve complaints about our collection or use of your personal information. 
United Kingdom candidates with inquiries or complaints regarding our Privacy Shield 
policy should first contact Pyramid at: DPO@PyramidCI.com    
 

Security  
Pyramid endeavors to protect the security of your personal information and your choices 
for its intended use. We use Secure Socket Layers or SSL technology to protect the 
transmission of sensitive personal information such as your Personally Identifying 
Information. We store your personal information on a secure server and use systems 
and procedures that are designed to protect the personal information we collect from 
unauthorized access, destruction, use, modification, or disclosure.  
  
Although we will take (and require our third-party providers to take) commercially 
reasonable security precautions regarding your personal information collected from and 
stored on the Site, due to the open nature of the Internet, we cannot guarantee that any 
of your personal information stored on our servers, or transmitted to or from a user, will 
be free from unauthorized access, and we disclaim any liability for any theft or loss of, 
unauthorized access or damage to, or interception of any data or communications. By 
using the Site or other Pyramid services, you acknowledge that you understand and 
agree to assume these risks.  
  
How Long We Retain Your Personal Information  
We will only retain the personal information we collect about you for as long as 
necessary for the purpose for which that information was collected, and to the extent 
permitted by applicable laws. We take steps to ensure that when we no longer need to 
use your personal information, we remove it from our systems and records and/or take 
steps to anonymize it so that you can no longer be identified from it (unless we need to 
keep your information to comply with legal or regulatory obligations to which we are 
subject).  
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Your Privacy Rights  
  
Your Right to Be Forgotten  
Pyramid Consulting, Inc. retains candidate and applicant data to comply with laws and 
regulations across a multitude of jurisdictions, and such data is kept for at least 90 days 
or longer, based on the last point of contact. Certain data artifacts are required to be 
retained in keeping with US, Canadian, EU, and other laws and regulations such as 
racial makeup, age, sex/gender, and credit or criminal records. All candidates residing 
within or subject to the European Union Jurisdiction may request an “Article 17” action 
under the GDPR at any time. We will comply within 24 hours. The data we retain will be 
anonymized, deleted, or obfuscated such that it no longer identifies you in any specific 
way. 
  
Your Right to Request Modification or Correction of Your Data  
Mistakes Happen. If you notice that we have made a mistake in your data, please let us 
know. You have the right to request a copy of all the data we have about you, and if you 
notice an error request that we fix it. This process is handled through our Data 
Protection Officer. You may contact us:  

a) by telephone, at +1 678 514 3500  
b) by following the Opt-Out or unsubscribe instruction contained in the body of any 

marketing e-mail from us  
c) by sending us an e-mail at DPO@PyramidCI.com, including a copy of the e-mail 

you have received and by typing “Remove” in the subject line of your e-mail d) 
by mail:   

Pyramid Consulting Inc.  
Attention: Pyramid Data Protection Officer  
3060 Kimball Bridge Rd. Suite 200  
Alpharetta, GA 30022 USA  

  
Marketing Communications:  
When you register on this Site, we may ask you to select whether you would like to 
receive text, email social media connections and electronic communications from us 
such as offers, news, event invitations and other promotional communications. You may 
withdraw your consent or opt-out of receiving such communications at any time by 
contacting us as described below:  

a) by telephone, at +1  678 514 3500  
b) by following the Opt-Out or unsubscribe instructions contained in the body of any 

marketing e-mail from us  
c) by sending us an e-mail at DPO@PyramidCI.com, including a copy of the e-mail 

you have received and by typing “Remove” in the subject line of your e-mail.  
d) by mail:   

Pyramid Consulting Inc.  
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Attention: Pyramid Data Protection Officer  
3060 Kimball Bridge Rd. Suite 200  
Alpharetta, GA 30022 USA  
 

Additionally, where we process your personal information 
for our interests you will have the right to object to such 
processing. Please be aware that where you object to this 
sort of processing it may affect our ability to conduct tasks 
as listed in this policy.  
You may contact us:  

a) by telephone, at +1  678 514 3500  
b) by following the Opt-Out or unsubscribe instruction contained in the body of any 

marketing e-mail from us  
c) by sending us an e-mail at DPO@PyramidCI.com, including a copy of the e-mail 

you have received and by typing “Remove” in the subject line of your e-mail.  
d) by mail:   

Pyramid Consulting Inc.  
Attention: Pyramid Data Protection Officer  
3060 Kimball Bridge Rd. Suite 200   
Alpharetta, GA 30022 USA  

  
Your election not to receive newsletters or promotional and marketing correspondence 
from us will not: (i) preclude us from corresponding with you, by email or otherwise, 
regarding your existing or past relationship with us, and (ii) preclude us, including our 
employees, contractors, agents and other representatives, from accessing and viewing 
your personal information in the course of maintaining and improving the Site.  
  
Requesting Access to Your Personal Information and Other Rights:  
You may also have the right under applicable law to request to review, access, correct, 
delete, port or object to our processing your personal information processed by us, and 
lodge a complaint with a supervisory authority. If so, you may do so by making a 
request to the DPO You may contact us:  

a) by telephone, at +1 678 514 3500  
b) by following the Opt-Out or unsubscribe instruction contained in the body of any 

marketing e-mail from us  
c) by sending us an e-mail at DPO@PyramidCI.com, including a copy of the e-mail 

you have received and by typing “Remove” in the subject line of your e-mail.  
d) by mail:   

Pyramid Consulting Inc.  
Attention: Pyramid Data Protection Officer  
3060 Kimball Bridge Rd. Suite 200   
Alpharetta, GA 30022 USA  
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Changes to this Policy  
As a high growth, global business, Pyramid will continue to assess this Policy against 
new technologies, regulations, laws, services, business practices, and the needs of our 
customers & candidates. Accordingly, changes to this Policy shall be made from time to 
time as required. Material changes to this policy will result in more prominent notice and 
may take many forms (such as email, a written hard hard-copy, or updates to our 
website, as appropriate to regulations, business practices, and customer needs.  

  
Data Protection Officer  
We have appointed a Data Protection Officer (“DPO”) for our global operations to 
address privacy concerns for our candidates and those who interact with us. If you have 
any questions or concerns about our personal data policies or practices, you may 
contact the DPO using the following contact details:   

a) by telephone, at +1 678 514 3500  
b) by following the Opt-Out or unsubscribe instruction contained in the body of any 

marketing e-mail from us  
c) by sending us an e-mail at DPO@PyramidCI.com, including a copy of the e-mail 

you have received and by typing “Remove” in the subject line of your e-mail.  
d) by mail:   

Pyramid Consulting Inc.  
Attention: Pyramid Data Protection Officer  
3060 Kimball Bridge Rd. Suite 200  
Alpharetta, GA 30022 USA  

  

Cookie Policy – Automatic Data Collection  
By browsing on our Site, you are agreeing to our use of cookies.  
  
What is a Cookie:  
A cookie is a small text file that a website stores on your personal computer, telephone, 
or any other device, with information about your navigation on that website. Cookies 
facilitate browsing and make it more user-friendly. A cookie contains the name of the 
server it came from, the expiry of the cookie, and a value – usually a randomly 
generated unique number. Cookies do not give access to nor damage your computer.  
  
How we use Cookies:  
We use browser session cookies, which are temporary cookies that are erased from 
your device’s memory when you close your Internet browser or turn your computer off, 
and persistent cookies, which are stored on your device until they expire, unless you 
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delete them before that time. We group browser cookies on our site into three 
categories, which you can manage through our Cookie Preference Manager:  

• Strictly necessary cookies: These cookies are necessary to enable the basic 

features of this site to function, such as identifying you as a valid user, ensuring 

that no one else can sign on simultaneously with your account from another 

computer and helping us serve you better based on your registration 

preferences. These cookies also allow you to select your cookie preferences.  

• Performance Cookies: These performance tracking cookies help us to track 

whether an e-mail recipient has completed an event, such as signing up for a 

free trial for example. Such information is non-personally identified and collected 

on an aggregate level. We sometimes utilize third-party service providers to help 

us track the activity within our Site and require third parties to comply with all 

applicable regulations and laws.  

• Functional cookies: Cookies allow us to analyze your use of the site to evaluate 

and improve our performance. They may also be used to provide a better 

customer experience on this site. For example, providing us with information 

about how our site is used and helping us facilitate any promotions or surveys 

that we provide.  

• Targeting cookies: These cookies may be used to share data with advertisers so 

that the ads you see are more relevant to you, allow you to share certain pages 

with social networks, or allow you to post comments on our site.  

  
Cookies Are Not Used to Store Sensitive Data:  
The cookies we use do not store sensitive personal information, such as your address, 
your password, or your credit card data.  
  
Performance Tracking  
We sometimes use cookies, as well as tracking technology, such as web beacons, 
within the promotional emails that we send to our subscribers or advertisements for our 
Site. These performance tracking devices help us to track whether an e-mail recipient 
has completed an event, such as signing up for a free trial for example. Such 
information is non-personally identifying and collected on an aggregate level.  
  
We sometimes utilize third party service providers to help us track the activity within our 
Site. These third parties may use temporary cookies and/or web beaconing technology 
to facilitate such tracking, but the data would not be tracked in a personally identifiable 
way.  
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Third parties whose products or services are accessible on our Site may also use 
cookies, and we advise you to check their privacy policies for information about their 
cookies and other privacy practices.  
  
If you would like more information about the third-party cookies on our website and to 
find out more about your choice to not have your information used by third parties, 
please contact us at DPO@PyramidCI.com.  
 
Managing Your Cookie Preferences  
  
Cookie Preference Manager:  
Our preference manager allows you to restrict our use of cookies other than Required 
Cookies. If you use our preference manager on a mobile device, we process your 
device’s Advertising Identifier. When you access our preference manager, persistent 
cookies will be set by the ad networks listed in our preference manager to honor your 
preferences if you choose not to receive interest-based advertising. If you clear your 
browser cookies, this will remove all cookies including the opt-out cookies set by the 
companies. You will need to re-access the opt-out tool to reset your preferences. Our 
cookie only knows your last set of preferences and does not reflect the current state of 
cookies on your browser.  
  
Do Not Track:  
Pyramid tracks cookies through your browser unless you proactively disable cookie 
tracking. or use the features of our Cookie Preference Manager.  
  
Avoiding Use of Cookies on this Site:  
If you prefer to completely prevent us from using cookies on your devices, before 
navigating on this Site, you must first disable the use of cookies in your browser and 
then delete the cookies saved in your browser associated with this Site.  
  
Disabling and Preventing Further Use of Cookies:  
You may restrict, block, or delete the cookies from this Site at any time by changing the 
configuration of your browser.  
  
Contact Us  
You are always free to contact us if you have questions or concerns regarding this 
Policy, have a question or problem related to your use of the Site, or wish to exclude 
your personal information from our direct marketing purposes. Our standard business 
practice is to retain any communications from our Site visitors to help us to serve each 
of you better.  
  
You may contact us by emailing DPO@PyramidCI.com or by writing to us at:  
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Pyramid Consulting Inc.  
Attention: Pyramid Data Protection Officer  
3060 Kimball Bridge Rd. Suite 200  
Alpharetta, GA 30022 USA  
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CA Consumer Privacy 
Act Policy and 

California Privacy 
Rights Enforcement Act 

Introduction 
 

What are CCPA and CPRA? 
The California Consumer Privacy Act (“CCPA”) was enacted in 2018 and took 
effect on January 1, 2020. It confers new privacy rights for consumers and 
imposes corresponding obligations on businesses subject to it. 
 
On November 4, 2020, California voters passed the California Privacy Rights 
and Enforcement Act (CPRA). The CPRA replaces and amends several parts of 
the existing Act, the California Consumer Privacy Act (CCPA). The new Act 
went into effect on January 1, 2023.  
 

CCPA vs CPRA – What has changed? 
The new data privacy act, California Privacy Rights Act (CPRA), expands on 
several areas of the existing CCPA. CPRA introduces new privacy rights for 
California’s people and adds more stringent regulations for businesses on the 
use of personal information. The CPRA has also established a new 
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government agency for the enforcement of data privacy laws in California, 
named the California Privacy Protection Agency (CPPA). CPRA: 
 

 expands the definition of “businesses” covered by the privacy act and 
includes those “sharing” information as liable as well. Commonly 
controlled businesses or businesses sharing common branding are 
exempted unless they also share consumers’ personal information. 

 introduces a new classification of personal information (PI), named 
sensitive personal information (SPI) that has additional use, disclosure, 
and opt-out requirements. This includes details like Social Security, 
state ID, driver’s license, financial account information, precise 
geolocation, religious or philosophical beliefs, non-public 
communication, genetic, biometric, and health data, etc. 

 requires companies holding high-risk data to conduct annual 
cybersecurity audits, the results of which must be submitted to the 
CPPA. 

 expands on the CCPA’s right to opt-out and states that companies 
must allow consumers the right to opt-out of third-party sharing for 
advertising purposes. 

 strengthens consumers’ rights by adding the right to delete or correct 
their personal information. If the said PI has been shared with third 
parties by the business, the business must notify them of the request to 
delete/amend as well. 

 expands on the consumers’ right to know provisions in the CCPA. 
 introduces changes in data governance and transparency, including 

limitations on storage, data minimization, and contract requirements. 
Only data that is necessary for the purpose stated by the business must 
be collected, used, or disclosed. Also, data must be retained only for as 
long as it is necessary for the said purpose. 

 

How does the CPRA compare with the CCPA? 
The CPRA can be called a refinement or upgrade of the CCPA. The CCPA 
formed the basis of the data privacy landscape of California. The CPRA builds 
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upon it to strengthen the privacy regulations in the State and bring it to par 
with the GDPR of the European Union. 

The CPRA does not replace the CCPA per se, but surely amends it to benefit 
consumers and increase the compliance requirements for small and big 
businesses alike. 

Though the CPRA went into effect on January 1, 2023, any data collected by 
businesses from January 1, 2022, will be subject to compliance with the CPRA. 
This is termed as the lookback period. 
 
Pyramid Consulting, Inc. is committed to protecting and respecting your 
privacy. This Privacy Policy for California residents (“Policy”) applies to 
personal information collected through our websites, applications, services, 
and in the course of routine offline business contact with you. It applies solely 
to all visitors, users, and others who reside in the State of California 
(“consumers,” “your,” or “you”). 
 
This Policy has been adopted to comply with the CCPA/CPRA and any terms 
defined in the CCPA/CPRA have the same meaning when used in this Policy. 
The terms “we,” “us,” and “our” refer to Pyramid Consulting, Inc., and our 
operating affiliate divisions (Genspark™ and Celsior Technologies™) (the 
“Company”). 

How will the CPRA impact businesses? 
Like any other comprehensive data privacy law, the CPRA also requires 
businesses to be more responsible with consumers’ personal information. 
Businesses will need to develop stronger data protection processes and 
controls to be able to respond to consumer requests quickly. Businesses will 
also need to be agile and adaptive enough to pivot in case of any new 
additions to the data privacy compliance requirements in the future. 

What Personal Information do we collect? 
For purposes of this Policy, “Personal Information” means information that 
identifies, relates to, describes, is reasonably capable of being associated 
with, or could reasonably be linked, directly or indirectly, with California 
consumers. 
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We may collect Personal Information from you in a variety of different 
situations, including, but not limited to, through our websites, your mobile 
device, through email, in physical locations, through the mail, and/or over the 
telephone. 
 
We collect Personal Information to operate, manage, and maintain our 
business, to provide our services, and to accomplish our business purposes 
and objectives. In particular, we may have collected the following categories 
of Personal Information from consumers within the last twelve (12) months: 

 Identifiers, such as names and government-issued identifiers (e.g., 
Social Security numbers); 

 Personal Information categories listed in the California Customer 
Records statute, such as contact information and financial information; 

 Characteristics of protected classifications under California or federal 
law, such as sex; 

 Biometric/Genetic information, such as fingerprints and voiceprints; 
 Internet or network activity information, such as browsing history and 

interactions with our websites; 
 Geolocation data, such as device location and Internet Protocol (IP) 

location; 
 Audio, electronic, and similar information, such as call and video 

recordings; 
 Professional or employment-related information, such as work history 

and prior employers; 
 Education information, such as student records, grades, and transcripts; 

and 
 Inferences drawn from any of the Personal Information listed above to 

create a profile about, for example, an individual’s preferences and 
characteristics. 

 Personal data revealing racial or ethnic origin, religious beliefs, mental 
or physical health diagnosis, sexual orientation, or citizenship or 
immigration status. Some of this information is typically included in 
resumes or can be derived from information contained in resumes.  
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Personal Information does not include: 

 Publicly available information from government records; 
 De-identified or aggregated consumer information; 
 Information excluded from the CCPA’s scope, such as: health or medical 

information covered by the Health Insurance Portability and 
Accountability Act of 2009 (HIPAA), the California Confidentiality of 
Medical Information Act (CMIA), or clinical trial data; personal 
information covered by certain sector-specific privacy laws, including 
the Fair Credit Reporting Act (FRCA), the Gramm-Leach-Bliley Act 
(GLBA), or the California Financial Information Privacy Act (FIPA); and 
the Driver’s Privacy Protection Act of 1994. 

 
The categories of sources from which we collected the Personal Information 
listed above include, but are not limited to: 

 Directly from job candidates/applicants and employees; 
For example, when they 

1. Contact the Company by phone, email, or otherwise in respect of 
any of its services; 

2. Apply for assignments that the Company has advertised on 
behalf of its clients or itself; and 

3. Complete contract assignments at client sites, including logs of 
work completed and hours worked. 

 Sources such as LinkedIn, corporate websites, job board websites, online 
CV libraries, business cards, personal recommendations, and the 
Company’s websites; 

 Service providers, including external payroll service providers, and other 
third parties; 

 Directly from clients, contractors, or their agents. For example, from 
information clients provide in relation to the services for which they 
engage the Company. 

How do we use Personal Information? 
We may use or disclose the Personal Information we collect for one or more of 
the following business purposes: 



  
  

CCPA - 2023 info@pyramidci.com www.pyramidci.om 

1. Job Candidate/Applicant Information – We generally use the 
Personal Information about job candidates/applicants in the 
following ways: 

1. Recruitment Services – Because a significant area of our 
business is providing recruitment services, we have listed 
below numerous ways in which we may use and process 
Personal Information for this purpose, when appropriate 
and in accordance with any legal requirements. This list is 
not exhaustive. 

 Collecting the information from job 
candidates/applicants and other sources, such as 
LinkedIn; 

 Storing the information (and updating it when 
necessary) in our databases, so that we can contact 
job candidates/applicants in relation to recruitment; 

 Providing job candidates/applicants with our 
recruitment services and to facilitate the recruitment 
process; 

 Assessing information about job 
candidates/applicants to compare it against 
vacancies that we think might be suitable for them; 

 Sending job candidates’/applicants’ information to 
clients, to apply for assignments or to assess their 
eligibility for assignments; 

 Enabling job candidates/applicants to submit their 
CVs, apply online for jobs, or subscribe to alerts about 
jobs that might be of interest to them; 

 Carrying out our obligations arising from any 
contracts entered into between the Company and 
job candidates/applicants; 

 Carrying out our obligations arising from any 
contracts entered into between the Company and 
third parties in relation to job candidates’/applicants’ 
recruitment; 

 Facilitating our payroll and invoicing processes; 
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 Verifying the details that job candidates/applicants 
have provided, using third party resources or by 
requesting additional information; 

 Complying with our legal obligations in connection 
with the detection of crime or the collection of taxes 
or duties; and 

 Processing job candidates’/applicants’ information to 
enable us to send them targeted, relevant marketing 
materials or other communications which we think 
are likely to be of interest to them. 

2. Marketing Activities – We may use Personal Information for 
the purposes listed below, when appropriate and in 
accordance with any legal requirements. This list is not 
exhaustive. 

 Enabling us to develop and market other services; 
and 

 Marketing our full range of recruitment services 
(permanent, temporary, contract, Managed Service 
Provider programs, etc.) to job 
candidates/applicants. 

3. We may use Personal Information to help us comply with 
legal or regulatory requirements for job 
candidates/applicants, including government reporting, 
investigations, legal proceedings, record-keeping, and for 
audit purposes. 

 Employee Information – We use the Personal Information of our 
employees for remuneration, taxation, pension, and benefits purposes. 
The information requested is necessary for the performance of our 
obligations under their employment contracts. If employees do not 
provide the information requested, we will be unable to pay them their 
wages, provide or register them for benefits, or facilitate claims for 
benefits. We may also process Personal Information as part of 
performance review processes and in relation to compensation, 
rewards, and benefits. We also keep employee training records. We 
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may also need to process Personal Information in connection with 
disciplinary, grievance, and dismissal processes. Additionally, we may 
use Personal Information to help us comply with legal or regulatory 
requirements for employees, including government reporting, 
investigations, legal proceedings, record-keeping, and for audit 
purposes. 

 Contractor Information - We may use the Personal Information about 
our contractors to: 

 Store (and update when necessary) their details on our 
databases, so that we can contact them in relation to our 
agreements; 

 Offer services to them or obtain support and services from them; 
 Perform certain legal obligations; and 
 Help us to establish, exercise, or defend legal claims. 

We may also use Personal Information to facilitate administrative functions, 
information technology operations, for legal reasons, and corporate 
transactions. These functions include, but are not limited to the following: 

 To manage and operate information technology and communications 
systems, risk management and insurance functions, budgeting, fiscal 
management and reporting, and strategic planning; 

 To manage litigation and other legal matters and inquiries, and to meet 
legal and regulatory requirements; 

 In connection with corporate transactions, sales, or assignments of 
assets; and mergers, divestitures, or other changes of control or of 
financial status of the Company or its subsidiaries or affiliates; and 

 To manage licenses, permits, and authorizations applicable to our 
business operations. 

With whom do we share Personal Information? 
When appropriate and in accordance with legal requirements, we may share 
Personal Information in several ways and for distinct reasons, including, but 
not limited to: 

 Any of our group of companies; 
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 Individuals and organizations who hold information related to job 
candidates’/applicants’ references or applications to collaborate with 
us, such as current, past, or prospective employers, educators, 
examining bodies, and employment and recruitment agencies; 

 Tax, audit, or other authorities, when we believe in good faith that the 
law or a regulation requires us to share this information; 

 Third party service providers who perform functions on our behalf; 
 Third party outsourced payroll providers when we have an appropriate 

processing agreement (or similar protections) in place; 
 For job candidates/applicants: 

 Potential employers and other recruitment 
agencies/organizations to increase the candidates’/applicants’ 
chances of finding employment; 

 Third party partners, job boards, and job aggregators when we 
consider this will improve the chances of finding them the right 
job. 

 Managed Service Provider (MSP) suppliers as part of our clients’ MSP 
programs; and 

 Vendor Management System (VMS) suppliers as part of workorder 
tracking, time capturing services for our clients. 

What are your CCPA rights? 
The CCPA provides certain consumers with specific rights regarding their 
Personal Information which they may exercise independently or through an 
authorized agent. It also includes several exemptions, however. For example, 
Personal Information about consumers who are current or former employees, 
job applicants, or contractors is generally exempt from, or outside the scope 
of, this section. 
The consumers who have these rights under the CCPA may exercise them in 
the following manner: 

1. Right to Access Information 
Consumers with these rights under the CCPA may request 
access to the Personal Information that we have collected and 
maintained about them (along with information regarding its 
use and disclosure) over the past twelve (12) months upon 
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appropriate verification. They may make such requests two (2) 
times every twelve (12) months. 

2. Right to Deletion of Information 
Consumers with these rights under the CCPA may request that 
we delete Personal Information collected and maintained 
about them, subject to certain exceptions. Once their request 
is verified and we have determined that we are required to 
delete that information in accordance with applicable law, we 
will delete their Personal Information accordingly. Any deletion 
request may be denied if it is necessary for us to retain the 
information under one or more of the exceptions listed in the 
CCPA, such as complying with a legal obligation. 
Please note that a record of the deletion request may be kept 
pursuant to our legal obligations. 

 Right to Non-Discrimination 
We will not discriminate against you for exercising any of your rights 
under the CCPA. 

How to make requests? 
Consumers who have access and deletion rights under the CCPA may 
exercise these rights by submitting a verifiable consumer request using one 
of the methods described below. 

 Email us at dpo@pyramidci.com. 
 Make the subject line of your email “CCPA Information/Deletion 

Request.” 
 Include your first and last name. 
 Identify which type of request you are seeking by including one of 

the following sentences in your email: 
1. This is a request to know categories of my Personal 

Information; or 
2. This is a request to know specific pieces of my Personal 

Information; or 
3. This is a request to delete my Personal Information. 

 Include this declaration: “I affirm that the information provided in 
this email is accurate, that I am the person whose full name is 
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specified above, and that I am the owner of this email account 
and a California resident. I understand that the Company will 
contact me at the email address provided to verify I am the 
person making this request.” 
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Pyramid Consulting, Inc. is committed to providing a website that is 
accessible to everyone, including individuals with disabilities. We are 
constantly working towards improving the accessibility of our website to 
ensure that we provide equal access to all of our users. 

What we are doing about web accessibility 
To make our website accessible to everyone, we have implemented the 

following features, among others: 

 Screen reader compatibility 
 Alt-tagged images 
 Keyboard accessible navigation 
 Adjustable font size 
 Adjustable color/contrast ratio 
 Labelled form controls 
 Sitemap 
 Search function 

Our website is compatible with the most popular free 
accessibility software and services, including: 

 JAWS, a screen reader for Windows. 
 NVDA, an open-source screen reader for Windows. 
 Lynx, a text-only web browser for blind users with refreshable Braille 

displays. Compatible with Windows, Macintosh, Linux, and other 
operating systems. 

 Links, a text-only web browser for visual users with low bandwidth. 
Compatible with Windows, Linux, and other operating systems. 

Instructions for increasing or decreasing the size of text and 
images. 
Microsoft Internet Explorer: 

 Press the Alt key to display the menu bar, click View, and then click Text 
Size; or 
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 Press and hold down the CTRL key, and while holding the CTRL key, press 
the + key to increase the size of the text and images or press the – key 
to decrease the size of the text and images. 

Mozilla Firefox: 
 Press the Alt key to display the menu bar, click View, then go to Zoom. 
 Select Zoom Text Only to adjust the size of the text. 

Apple Safari (OS X): 
 To enlarge the entire page, choose View > Zoom In, or press Command 

(⌘) and the + key. 
 To enlarge only the text, choose View > Zoom Text Only, and then 

choose View > Zoom In. 
Google Chrome: 

 Click the Chrome menu on the browser toolbar. 
 Select Settings. 
 Click Show Advanced Settings. 
 In the “Web Content” section, use the Font Size drop-down menu to 

make adjustments. 

Instructions for adjusting the color/contrast on our website. 
Microsoft Internet Explorer: 

 Select the Tools menu (Shortcut: ALT + X). 
 Select Internet Options. 
 Select the Colors button in the bottom left-hand corner (Shortcut: ALT + 

O). 
 Ensure the “Use Windows colors” check box is not selected 

(Shortcut: ALT + W to toggle on/off). 
 Choose your desired colors by selecting the color box and then 

choosing from the available colors. You can change the colors for text, 
background, visited and unvisited hyperlinks and hover. 

 Select OK on the Colors screen. 
 Select OK on the Internet Options screen. 

Mozilla Firefox: 
 Select the Tools menu (Shortcut: ALT + T). 
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 Select Options. 
 Select the Content option in the top-middle of the menu. 
 Select the Colors button on the middle, right-hand side. 
 Choose your desired colors by selecting the color box and then 

choosing from the available colors. You can change the colors for text, 
background, and visited and unvisited hyperlinks. 

 Uncheck the Use system colors box. 
 Select OK on the Colors screen. 

Apple Safari (OS X): 
 Select the Safari menu, then select Preferences. 
 Select Appearance, which is the second option on the right. 
 Under Standard font, select the Select button. Choose your desired font 

type, size, and color. 
 Click OK on the Preferences screen. 

Google Chrome: 
Google makes available extensions that allow you to adjust the colors of 
Google Chrome, which you can find on the Google Chrome Extensions 
website. Simply visit the website and search for “color change.” 

 When you find the extension you would like, click Add to Chrome for 
installation. 

 Once installed, you will see the icon for the extension at the end of the 
URL field. 

 Right-click on the icon, and you will be able to change the background 
color, text color, links color, and visited links color. 

Questions or feedback 
If you have any questions or feedback regarding the accessibility of this site, 
or if you experience any difficulty using it, please contact us at 
marketing@pyramidci.com and we will be happy to help. 
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